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The Anything Academic Test Generator is great because it will allow teachers to
create and store tests that they will use as part of their class curriculum. More
importantly, however, it will allow teachers to create their test questions once and
then it will give the teacher the power to instantly generate a random, sequential,
or selected multitude of tests based on the original questions devised. This is
extremely helpful when teachers have a group of classes covering the same
subject area and tests are given to each class – one following the other.
I found that when similar classes take tests sequentially throughout the day (or
on alternate days), some students have a tendency to consult with students who
have previously taken the test. This wouldn’t be so bad if they were really trying
to learn about the subject from the knowledge they acquire, but many of them
simply want a rote summary of the information – answers or questions
memorized in sequence, so they can simply fill in the blanks, regardless of what
they should have learned.
I often felt that it would be a boon to our testing environment if teachers could
generate different versions of the same test, without a lot of work. For example,
it would be helpful if we could take a twenty or thirty question test and quickly put
together four or five variations of this test. Each test would be the same content
for each class but with questions arranged in different orders.
I tried this by hand for a while when I was teaching, and it was amazing how
many students I caught with red faces, when they ultimately realized that the test
wasn’t exactly like the one their friends took yesterday. On a multiple choice test,
for example, some students (in a misguided attempt at helping their mentally
challenged buddies) memorized the sequence of questions and answers. When
the recipients tried using the same sequence of answers (without even reading
the questions) they were stunned at the terrible grades they received. Hopefully
they learned a lesson.
Well, generating a group of tests for the myriad of topics I was covering became
quite a burden, so I decided it would be handy if I had a computer program in
which I could do the following:
•

Create collections of these kinds of questions: fill-in, short answer, multiple
choice, open-ended response

•
•
•
•
•

Save these collections of questions as files that I could edit and reuse in
the future.
Quickly and easily use the files of questions to generate tests with
questions randomly selected from the entire file.
Quickly and easily use the files of questions to generate tests with
questions randomly selected from selected ranges of questions from the
entire file.
Quickly and easily use the files of questions to generate tests with
questions I select from the list of question in the entire file.
In all of the above cases the program should also provide a neatly
formatted list of answers for each of the questions asked.

Notice that the key words from this list are quickly and easily. Teachers have lots
of work to do, and a lot of this work eats up preparation time. A computer
program that would do this prep work would save a lot of time that could be
better spent on other jobs.
The Anything Academic Test Generator will do the tasks outlined above. In
addition, you can also format your finished tests the way you want them (you can
even paste graphics into the final test you create); save the generated tests in
named files, for use in the future; copy and paste your test information into other
documents in your favorite word processor; search for and insert information in
your final tests, and print hard copies to your printer. The Anything Academic
Test Generator even includes a test editor, so that you can quickly and easily
make up your test data and save it in a format that The Anything Academic Test
Generator can import. We have even included a simple search puzzle make,
too. This is handy for creating search puzzles based on vocabulary, characters,
key terms, etc. Version 3.2.0 now has two additional add-ins: Multiple Choice
Test Generator and Multiple Choice Test Editor. Seem Appendix I below.
Installing The Anything Academic Test Generator
Installation of The Anything Academic Test Generator is relatively easy. First of
all be aware that this software only runs on Window PC machines. It will not
work with MAC or other types of operating systems. If you received the
installation on a CD, simply insert the CD in drive on your computer. If you have
autostart set on your computer the CD will start up automatically after a few
moments of initialization.
If the installation does not start automatically, simply open My Computer on your
Windows desktop and double click the CD drive icon to open the CD window.
Then double click the setup.exe file to get the installation started.
In both cases above, read the installation screen to complete installation on your
computer. After installation is complete, store your CD in a safe place for backup
use in the future. You won’t need it in the drive to run the program.

If you received your installation via download form the internet, save the file to a
new folder you create on your Windows desktop. You will need WinZip installed
on your computer (available as a free download from www.winzip.com) to unpack
The Anything Academic Test Generator installation. If you already have WinZip
installed, double click the file you downloaded and WinZip will give you
instructions to unpack the installation and documentation files to the same folder.
Once this is completed you will have the same files that would be found on the
CD. Simply double click the setup.exe file and follow the screen directions to
install the program on your Windows machine.
Using The Anything Academic Test Generator
Once you have installed The Anything Academic Test Generator on your
Windows PC, you will see a shortcut icon on the desktop. Double click this with
our mouse button and a splash screen will appear for a few moments. This will
be followed by the program’s main screen, illustrated here.
The Anything
Academic Test
Generator is
ready to go to
work for you.
Just about any
teacher will find
this program
helpful. We
have included a
couple of
sample
question/answer
files for you to
experiment with.
On the main
screen all you
can do right now
is type in the
large text
window at the
bottom. You could use this if you just want to generate some text or a note, as
you would with any word processor. The real power of The Anything Academic
Test Generator, however, is in the manipulation of test data that you create.
Before getting into the process, let’s take a closer look at the screen and menu
controls.

At the bottom of the text window there is a status bar with current
information about the file being used. Just above the text window you will find a
format bar, which will allow you to format text you enter in the text window. This
works similar to most word processors. First you must highlight text in the
window before making changes to the font type, font size, font color, and the text
window background color. Most of the time you will probably not even have a
need for these functions, but they are there is you choose to use them.
At the top of the screen you will see a menu bar. Here is where you will go for
many of the program’s important functions. Let’s take some time to review the
features of this bar (below it many of the same functions are graphically
represented on a toolbar).

The drop-down File menu has the options to start
New, when you want to import or generate a new
test format. Open A Test File… will allow you to
open final tests that you have saved. You will only
be able to edit and print these saved tests. Save
and Save As… will allow you to save final
versions of the tests you create. Print Current
Test will allow you to send the test on display to a
printer you have attached to your computer. Exit is the only legitimate way to
close the program when you are done. Make sure you save any tests you have
created before exiting the program.
The drop-down Edit menu allows you to Select
All (contents of the text window). Cut or Copy
Selected Text. Paste Text (in the text window).
Clear Selected Text (from the text window).
Word Wrap text in the text window (This is a
toggle switch to turn this feature off or on. It is on
by default -- checked.). Find Selected Text in
the text window. This feature can be very helpful
in a long test when you want to locate a small
piece of information. These features are grayed out if there is no text in the text
window to be manipulated, as you can see by the
illustration here.
The Actions drop-down allows you to Make Puzzles from
the default word list (customizable). Clear (all) text
windows. Open the Multiple Choice Test Generator.

Open the Multiple Choice Test Editor. Open Question Editor (for generating
new data files of questions and answers). Import Your Question List (data files
for use in generating new tests).
The View drop-down menu offers two features.
These are toggle switches again (checkmark
indicates they are on. With these you can turn
the Toolbar and Status Bar on and off screen
view.
The Insert drop-down menu allows you to Insert
Date/Time into a selected area of the text
window. Test you generate will have a generic
heading on them. You might like to select the
heading and insert a Default Heading we have created. You can alter this also
if you like, after insertion.
The Font drop-down menu will allow you to
design the font you want to use in the text
window. You will have to select the text first
before making a selection from this menu. The
functions on the toolbar perform these same
actions. Format Font, Font Color, Bold
Selected Text, Italicize Selected Text, and Underline Selected Text.
The Options drop-down offers one option. This is
a toggle switch too, that allows the user to
Preview Font (in the font window) as it will
actually look if selected.
The About drop-down will give the user information
about Baggetta_Ware.
The graphic Toolbar does many of the functions, with a few added features,
shown here.
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The center of the main screen contains the control and test information panel. At
the start of the program this panel is blank and disabled.

The control and test information panel is where you will find information about the
current file of questions available. Once you have Imported a question and
answer file (created by you), this panel will then be available to generate three
types of tests: Random Tests, Sequential Tests (plain or randomized), and
Selected Questions Tests. Let’s experiment with a sample test included with the
installation.
First, let’s Import the Sentences With Synonyms
question and answer file. You can do this by clicking
the Actions option on the menu bar and from the
drop-down menu select Import Your Question List.
A dialog box will open. Use it to navigate to the folder
in which you keep your question and answer files.
The sample file is found in the program directory.
All of your question answer files will
have a .tga extender on them. Do
not try to open other files with this
option. Doing so could cause an
error in the program, forcing you to
restart.
After you have selected the file you
want, click the Open button to place
the information on the control and
information panel.
As you can see from the illustration
below, the panel is now loaded for
use.

There are 10 questions in the Sentences With Synonyms file. The title of the
files shows just above the program Toolbar, and a label on the Toolbar indicates
that and a file has been imported Import Added. The Remove button along side
the label can be used to quickly remove your imported file, if you no longer want
to work on it. This is similar to the clear option on the Menu Bar.

Generating Tests
Okay. Now we are ready to generate a test. Let’s generate three different test
formats, using the Sentences With Synonyms file. The first test we will create
will be a short quiz of five questions only (remember we have ten questions to
work with). We’ll use the Generate Random Test button, but first we have to
enter a number in the text window to the right of the maximum label. Type the
number 5 in the window and then click the Generate Random Test button.
Instantly you will have a five question quiz randomly selected from the question
file of ten questions. The screen will look like the illustration here.
You will notice that
the questions in this
file are set up as
multiple choice.
The students will
have to write one of
the choices – not
letters or numbers.
The interesting
feature here is that
if you don’t like this
combination of
questions, you can
just click the
Generate Random
Test button again to
get a different
combination. Also,
if you like this
combination, but
want to type in
additional information or add a graphic to this test you can type in your
information or paste a graphic into the text box. You can also add line spaces to
make more room, if you like. And of course you can use the formatting features
to change other characteristics of the final test. DO NOT add anything, however,
if you plan on using the Generate Random Test button to create another version
of the quiz. Only make changes to the final version you will save or print.
If you scroll down the textbox page, you will find the answers to the questions
you have created for the quiz. These are numbered accordingly. If you plan on
printing from the program, you might want to tap down a few lines (using the
computer Enter key) to make sure that your answers appear on a separate page
for your use as a test key. You wouldn’t want to print these for your students to
use.

The Sentences With Synonyms file is a short collection of only 10 questions
and answers, but we can use this to illustrate the next type of test you can
create, a sequential test, generated with the Generate Sequential Test button.
If you had a really long file of questions, this would be more effective. But let’s
say you only want a five question quiz from this file using only questions 3, 4, 5,
6, and 7 from the file, in that order. To do this first type the starting question
number in the Start With… textbox. The number must be above 0 and below 11
for this file, of course. We will type a 3 in the box. In the End With… textbox
we’ll type the number of the last question we want and that is the number 7
question.
When you have done this, click the Generate Sequential Test button to get your
results in the text window. You should get a quiz made up of the five questions
as they appear in the original text file (answers at the bottom, also), as illustrated
here.
You might want
different
versions of this
test (questions 3
– 7 placed
randomly as 1 –
5). You can do
this by check
marking the
Randomize
Sequential
Tests box next
to the End
With… box.

Now, when you
click the
Generate
Sequential Test
button you will
get randomized version quizzes of the five questions you opted for. Pretty neat,
huh? This will be very striking when you are working with longer files of
questions, and it will give you an almost infinite number of tests in your arsenal.
Sometimes you might just want to pick the questions from the saved file and use
them to make up a quiz or test. Again, using the same file, let’s create a quiz of
question we want. We’ll use questions 2, 5, 6, 7, and 10. To do this we will use
the Selected Questions button.

When you click the
Selected Questions
button, you will get
another window that
will open on screen.
For this file, it will look
like the illustration
here. All of the
questions in your file
are listed here
numerically and each
has a check box placed
to the left of the
numbers.
You can select the
questions you want to
use in your selected
questions quiz by
clicking the respective
check boxes. You will
be able to scroll down
the window if there are
more questions you can’t see. When you have completed your selection, click
the Add Selected
Questions button to
place your selections in
the bottom window.
You can remove
question you don’t
want by reversing the
process, using the
bottom window and
then clicking the
Remove Questions
from Selection button.
If you are happy with
the questions you have
selected, you can then
generate your quiz by
clicking the Generate
A Selected Test
button, located at the
bottom of the screen.
If you change your

mind about this test altogether, just click the Cancel Test button to return to the
main screen.
That’s all there is to generating a multitude of tests and quizzes on just about
anything you are teaching.
After you generate a test (or while you are working on one), be sure to save our
work using the Save (or Save as…) option on the Menu Bar. If you do this you
will assure yourself that you will have these tests to use or edit in the future.
A word about printing. The Anything Academic Test Generator is designed
mainly for creating tests and answer keys that teachers can use for in their
classes. You can print from the program, but we suggest that you use the
printout for your use in making copies of the tests you create. You will want to
make sure that the answer key is not included with the test you copy for your
students and it is generally more economical to use a photocopier to make
duplicates for your class rather than printing an entire class worth of tests from
your printer.
Don’t forget too, that you can copy the contents of the text window in this
program and paste the contents into a more elaborate word processor for printing
or formatting.
Generating Search Puzzles
The Anything Academic Test Generator will allow you to create search puzzles
for your students to work with. These could be based on vocabulary,
terminology, characters, foreign words, etc. You decide. The program uses a
default list of vocabulary words located in a file in the program directory. This file
is called DefaultWordList.wds. This is simply a text file, but it must have the .wds
extender at the end and the file must be placed in the program directory. The list
contains 35 words from which the default search puzzle will be constructed.
You can create your own DefaultWordList.wds file and save it to the directory
(overwriting the old one), using your own list of words or other data. Simply use
Microsoft Notepad, which comes with Windows, to create the list. Type one entry
per line and then tap the Enter key to move down a line. The program will only
accept 35 entries (you can have less) from which to make puzzles. Save your
file when you are done. If the .wds file is removed from the directory you will get
an error at the start of the program. To fix this simply create a .wds file and save
it to the program directory.
To generate a search puzzle click the Make Puzzle option on the Actions dropdown menu. This will open the puzzle window.

The puzzle screen will
be blank when you first
enter it. Click the
Show Puzzle button
and you will get the
answer pattern created
by the program for the
default list of words. If
you don’t like the
structure of the puzzle
answers, click the
Revise Puzzle button
to get a different
version, until you are
satisfied.
You can take a look at
the default list by
clicking the Show
Word List button at the
bottom of the screen.
You will get a scrollable
list to view. You can
close the list window by
clicking the Show
Word List button again. This also acts as a toggle switch – off and on.
When you are happy with
the arrangement of the
answer scheme, you can
click the Generate Puzzle
button to construct the final
puzzle. Here we show the
finished puzzle and the word
list on display.
The final puzzle can be
printed from the program or
it can be copied and pasted
into a word processor for
final printing.
Tot get to the print preview
screen, click the Print
Puzzle button.

You can’t see the
complete page in the
preview window
unless you scroll
down. The puzzle is
printed at the top of
the page and the list
of hidden words is
printed at the bottom.
You can do a quick
printing of the puzzle
using the Quick Print
button. If you would
like a fancier more
formatted print out,
we suggest you
highlight the entire
puzzle and copy and
paste it into your
favorite word
processor. Use the
Close button when
you are finished.
Making Question and Answer Files To Import Into
The Anything Academic Test Generator
The power of The Anything Academic Test Generator is dependent on the files
you create for your tests. These are the original files of questions and answers
that the program will use to manufacture the myriad of tests you will require.
They are no more difficult to create than the tests you regularly make for your
classes, but now these one-time collections of questions and answers can be the
basis of hundreds of different tests that can be used over and over again.
Questions you originate can be just about any type. Here are some typical
formats:
•
•
•

Simple fill-in questions. This can be a statement with a blank line that
requires the students to answer with a word or phrase to complete it. It
doesn’t necessarily have to be in the form of a question.
Multiple choice. The question or statement is presented, followed by three
or four possible choices as answers.
Short Answer. The question or statement is presented and students must
provide an appropriate short answer.

•
•
•

Vocabulary. A definition is given that requires a studied word, or vice
versa.
Problems. A problem is offered and the solution must be given by the
students.
Open Ended Question. An idea is offered and students must respond with
their solutions. Your acceptable answers might just be suggestions.

When planning the question and answer files you will be using, keep in mind the
following set up format.
You will need a question.
You will need and answer for the question.
There are two ways to make the original files used by The Anything Academic
Test Generator. You can make them manually by using any standard text editor
or word processor that can save files in text format. You can also make them by
using our hand Question Editor that is built into The Anything Academic Test
Generator menu, under Actions.
Using A Text Editor or Word Processor
If you create your question and answer file using a text editor (Microsoft Notepad,
for example), open a New document and set Word Wrap on. Type your
information using the following format exactly:
On the first line type the title of your question answer file
On the second line type the number of questions you will have in the file
On the next line type the first question
On the next line type the first answer
On the next line type the second question
On the next line type the second answer
Continue this pattern until you have typed all of your questions and answers.
When you are finished, Save the file as a text file (this is especially important if
you are using a word processor which usually saves as a document file). Some
text editors automatically attach a .txt extender at the end of the file. If this is the
case, after you save your file, locate it using My Computer or Explore and use
the Rename option of Windows to change the extender from .txt to .tga. If you
don’t have this extender on the end of the file name it will not be recognized by
The Anything Academic Test Generator.
If you want to see how the actual files are constructed open the sample files that
accompany the program installation in your text editor and take a look at them.

Using the Question Editor in The Anything Academic Test Generator
We have made question and answer file creation a bit easier with the inclusion of
the Question Editor. You can get to this editor through the program Menu Bar.
Click Actions and then click Open Question Editor. The blank editor will open
on screen and look like the illustration here.
This add-in
program makes
file construction
easy because
you will only be
typing one
question and
answer at a
time. If you
want to open our
sample file or
any other file
you create, use
the Open File
button. To start
a new file, click
the New File
button. First you might wan to click on the File Name textbox to type in the title
of your question answer file. Make the name simple and recognizable. After you
put in the name you can start creating the questions and answers for your file.
Type a question in
the Question
textbox and then
tab down to the
Answer textbox to
type the correct or
suggested answer
for this question.
Click the scroll bar
at the bottom of the
screen to go to the
next question.
Continue typing
questions and
answers until you
are done, and then click the Save File button to save your question and answer
file. We suggest that you make a new folder with subfolders somewhere on your
computer that will house all of your question and answer files.

If you decide not to use the file you can use Abort Work to stop work on a file
and simply Quit to return to The Anything Academic Test Generator.
APPENDIX I: Multiple Choice Test Generator
New to version 3.2.0 The Anything Academic Test Generator is the ability to
create multiple choice test. These tests are built differently from the regular
questions imported into the generator so we have a separate add-on program to
do the work and also a special multiple choice editor to prepare your list of
questions with ease.
Before using the Multiple Choice Test Generator you will want to create a list of
questions and answers. Once you have this list of material you can use the
Multiple Choice Test Generator to create many variations on the list. So let’s
take a look at the Editor first, to see how it works.
To get to the editor, start The Anything Academic Test Generator and click the
Actions menu at the top of the screen. On the drop down list, click Open MC
Test Editor. It is the fourth option on the dropdown list. You should see the editor
appear on screen and it looks like the image here.
This looks similar
to the regular test
editor also built
into AATG, but it is
refined to accept
multiple choice
questions and
possible answers.
At the top of the
screen is the
control panel
which will allow
you to start a NEW
FILE, OPEN FILE,
SAVE FILE,
ABORT FILE, and
QUIT.
You can see that there are boxes to type your question and four possible
answers – the first answer will always be the correct answer. This is important,
otherwise you will not get correct results in the answer keys.
At the bottom left there is a scroll bar which you will use to move back and forth
through the questions as you create them, and at the bottom right is a box where

you should enter the title for your test. Keep this reasonably short. Here’s what
the editor looks like when you have completed work on a question or series of
questions and answers.
When you have
complete all of
the questions
and answers you
want in this file,
be sure to SAVE
your file with a
unique name that
you will
recognize and in
a location on
your hard drive
or network you
will have access
to. The file will
be automatically
appended with
an .mct extender.
Make sure you have typed only the number of questions and answers you want
to use in the test variations.
Use QUIT to close the Multiple Choice Test Editor when you are through creating
lists of questions and answers.
When you have a multiple choice file created that you want to use, you can
create multiple variations
on this database using the
Multiple Choice Test
Generator. Here’s how
you access it. On the
Academic Test Generator
menu, click the Action item
again and from the
dropdown menu this time
select Open MC Test
Generator. This is the
third item on the dropdown
menu. The test generator
opens and looks like the
image here.
Before you can use the
Multiple Choice Test

Generator (MC), you must open the file you just created, or some other that you
have stored away. You can easily do this by clicking
the Files menu at the top of the screen and from the
dropdown list select Open Multiple Choice
Database. Do not try to open other than an .mct file.
They will not work. If you have a correct file the
menu will close and a red message will appear on
screen indicating that your file is now ready to use.
At the top of the screen you will notice a control panel with some large buttons
and some option dots.

The control panel has three separate additional panels and each will determine
how your variation of the questions and answers will be set up. In each separate
panel you have the choice of having your answer key displayed as Word
Answers or Letter Answers. Each question will automatically be labeled as A., B.
C., and D., followed by respective answer choices. If you click the Word Answer
dot (the default for each of the panels at the start), your answer keys will be
displayed as a list of words or phrases , each numbered according to the
question it pertains to. If you choose Letter Answer, then the answer key will
only show the correct letter that should have been chosen to answer the
question.
To quickly generate a test or worksheet from any of the panels, click the
corresponding large button for that panel. Here’s what you will get for results
using each button:
Sequential and Answers will give you a test that uses the exact order you
entered the questions and answers in the file you created. But every time you
click the button the order of the questions will vary. It would be most effective to
produce an answer sheet using Word Answers rather than Letter Answers for
this option.
Random Questions and Answers will give you a test that changes the order of
each question in the list and a different order for the answers.
Sequential Questions and Random Answers will give you a test that keeps the
original order of the questions, but changes the order of the answers for each
question.

This might seem a bit confusing at first, but once you start using the Multiple
Choice Test Generator, you will easily become accustomed to its features. A
completed test will look like the illustration here.
If you are satisfied with
the test as it is, you
can now transfer this to
the Anything Academic
Test Generator screen
for further modification
(different spacing, add
images, etc.).
You can do this easily
by clicking the Files
menu at the top of the
screen and selecting
Close With Save (this
is the third item on the
dropdown menu.
If you select Close
With NO save all of
your work on the
generated test will be
discarded.
When you want to save
this test to use, click
Close With Save and your
file will be transferred to
the main test generator
screen, as shown here.
From here you can now
modify the file any way
you want, even adding
graphics, and then print,
using the Print option
found on the File menu.
If you want to use any of
the regular functions of
the program you will have
to clear the Multiple
Choice test first, using the

New option on the File menu.
PROGRAM UPDATES and SUPPORT
As with all Baggetta_Ware products we have tried to keep this software simple to
use and yet functional enough to make it useful. We hope to improve the
program yet and welcome any suggestions you might have. You can forward
them to us through our web page or directly via email at the following address:
baggetta@baggetta.com.
If you encounter any problems with the program, we will try to help you resolve
them as quickly as possible. Please send us email at the above address
detailing the problem. Be sure to include information about your computer
system makeup and any error messages you might encounter. Baggetta_Ware
and affiliates are not responsible for any damage caused by unforeseen bugs or
issues to other software and hardware you may be using. Do not use this
software if you cannot agree to these terms.
You can register your purchase on line at our site www.baggetta.com
A. Baggetta
Baggetta_Ware

